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Introduction  
This manual is the primary source of information for test centers for setting up and administering the TOEIC 

Speaking and Writing tests via the Web-based delivery platform. It defines the responsibilities and duties of the test 

center staff and describes the specific procedures that must be followed before, during, and after each test 

administration to ensure that the administration of tests is efficient, fair, and secure.  

This manual will help you prepare to:  

  Understand TOEIC test security policies and procedures  

  Select testing facilities  

  Select and train proctors  

  Prepare testing computers for exam delivery  

  Administer the TOEIC Speaking and Writing tests via the Web-based delivery platform  

  Respond to irregularities  

 

Related Documents  
 

The following related documents will be needed in addition to this manual when setting up a new test center:  

 TOEIC Irregularity Report Form – Complete this form to provide a record of any administrative problems 

and unusual situations that occur during a test administration. It is available from AMIDEAST.  Note:  This 

form is only for administrative issues. Technical issues should be documented on the TOEIC Post-

Administration Technical Feedback Report Form.   

 TOEIC Post-Administration Technical Feedback Report Form – Complete this form only if technical 

problems occur during a test administration. List all technical problem(s) and specify which candidate(s) 

and computer(s) were affected. This form is available from AMIDEAST.  
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Contacts   

ETS will provide support to the test center for all administrative issues and common (level 1) technical issues. This type of 

support includes but is not limited to direct customer support and immediate technical support.    

Refer to “Appendix G:  Handling and Reporting Technical Problems ” to resolve level 1 technical problems with starting a test. If 

you are not able to resolve the problem, follow the problem escalation procedures described below. 

How to Escalate Issues to ETS Technical Support 

During Test Administrations  

For urgent problems encountered during scheduled test administrations, call 1-609-406-5685 for live support during business 

hours (Monday through Friday, 8 AM through 8 PM EST/EDT [New York time], excluding ETS holidays).   

If prompted, leave a brief message describing the nature of the problem along with your contact number (including country and 

area code). Leaving a message triggers auto-notification to an on-call support staff member who will return your call promptly 

(within approximately 15 minutes).  

Non-Urgent Technical Issues  

For assistance with non-urgent technical issues, send an e-mail message to TOEICTech@ets.org , and provide the following 

information:   

 

  The authorization number(s) of the examinee(s) who experienced the problem   

  A clear description of the failure and the error messages displayed, if any   

  The exact step or point of failure (e.g., section and question number)   

  Operating system (e.g., Windows XP or Windows 2000) on the computer  

  Internet Explorer version (e.g., IE 6 or 7)   

E-mail requests will receive a response within one business day (Monday through Friday, 8 AM through 8 PM EST/EDT [New 

York time], excluding ETS holidays).   

Post-Administration Technical Feedback Report  

After a test administration during which you experienced technical problems, complete a Post-Administration Technical 

Feedback Report to document the issues. As requested on the report, list all technical problems that occurred (even if the 

problems were successfully resolved), and specify which candidate(s) and computer(s) were affected. E-mail the completed 

report to TOEICTech@ets.org within two business days after the test administration. For more information, see “Filing a Post-

Administration Technical Feedback Report” in Appendix G. Note: If no technical problems occurred, you do not need to submit 

a feedback report.  

Irregularity Reports for Non-Technical Issues  

Completed Irregularity Reports should be submitted to AMIDEAST. For information about filing Irregularity Reports see 

“Chapter 4:  Non-Technical Irregularities and Exceptional Situations.” 

Contacting TOEIC Product Management  

To receive assistance with administration related issues or questions, the test center should send an e-mail message to 

TOEICSWAdmin@ets.org 

mailto:TOEICTech@ets.org
mailto:TOEICTech@ets.org
mailto:TOEICSWAdmin@ets.org
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Quick Reference Checklist  
 
Before Test Day                                                              Reference  
 Facilities:  Ensure that the test center and testing rooms meet TOEIC requirements.  “Facilities and Environment” on 

page 1-1  

 Staff:  Appoint a TCA and the necessary number of proctors and inform them about 

their duties and responsibilities.  

“Test Center Staff” on page 1-6  

Testing Stations:  
 Ensure that all computers meet the hardware and software requirements.  

 Configure Internet Explorer

 Install the audio browser and Windows Media Player.  

 Install headsets, and run a system check of the screen settings and the audio 

recording and playback functions.  

 Run a center/computer check.  

 Perform the audio quality verification procedure.  

 If the number of Estimated Users determined by the center/computer check is less 

than the number of examinees you plan to test simultaneously, run a stress test.  

  

Appendix A   

Appendix A  

Appendix B  

Appendix C   

Appendix D  

Appendix E  

Appendix F  

 Schedule a Test Administration Date:  Provide the required advance notice to 

AMIDEAST via the Test Use Application Form   

 

 Print Rosters and Authorization Number Forms  

AMIDEAST will email these to you prior to the administration date.  Please ensure 

that you have received them, and prior them prior to exam day. 

 

 

On the Day of the Test                                                                     Reference  

Registration Materials:  Bring out rosters, Authorization Forms, and writing 

utensils.  

“Preparation Before Examinees 

Arrive” on page 3-1  

 Set Up the Testing Room:  Make any necessary adjustments (set up partitions; 

remove maps and charts, etc.)  

“Preparation Before Examinees 

Arrive” on page 3-1  

 Set Up the Testing Stations:  Confirm that audio browser is installed, headset is 

connected properly, and bandwidth is sufficient.  

“Preparation Before Examinees 

Arrive” on page 3-1  

Check In Examinees:  Check ID, provide a writing utensil and Authorization 

Number Form, escort examinee to assigned testing station.  

“Checking In Examinees” on page 

3-4  

 Start the Test; Collect Authorization Number Forms  “Starting the Test” on page 3-5  
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On the Day of the Test (continued)                                                Reference  

 Monitor the Testing Room; Resolve Any Irregularities  “Monitoring the Testing Room 

and Handling Irregularities” on 

page 3-14  

 End the Testing Session:  Ensure that “Completed Tests” is displayed, ensure that all 

Authorization Number forms have been collected, and note any “no shows” and 

corrections to Authorization Number Forms.  

“Ending the Test Session” on 

page 3-15 x 

 
After the Test                                                   Reference  
Email AMIDEAST to confirm the number of candidates who have tested.   At 

English4success@amideast.org.  Indicate the names of any no-shows.   

 

 

 If a technical problem occurred, send a Post-Administration Technical Feedback 

Report to TOEICTech@ets.org (even if the problem was resolved).  

“Filing a Post-Administration 

Technical Feedback Report” on 

page G-4  

 If a non-technical irregularity occurred, complete and submit an Irregularity 

Report AMIDEAST (Email to english4success@amideast.org).  

“Chapter 4:  Non-Technical 

Irregularities and Exceptional 

Situations” on page 4-1  

Retain used Authorization Number Forms in a secure location for six months; then 

destroy them.  

“Ending the Test Session” on 

page  3-15  

 

mailto:English4success@amideast.org
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Chapter 1:  Test Center Requirements and Testing Regulations  
Facilities and Environment  

The success of any test administration depends on the suitability of the test center. The testing rooms must provide the best 

possible conditions for student performance.   

Examinees cannot do their best if distracted by conditions such as noise, poor lighting, inadequate writing surfaces, or extreme 

temperatures. Although some adverse conditions may be beyond the control of the test center, the Test Center Administrator 

(TCA) must use best efforts to minimize the possibility of such distractions through careful planning.  

The test center must meet all local and national requirements for facilities that accommodate the public. In addition, the test 

center must meet the minimum special requirements listed below in “Physical Requirements, Comfort, and Environment.” If any 

of those requirements conflict with local or national requirements, the local or national requirements shall take precedence, 

provided that the intent of the testing program is not abridged.  

Physical Requirements, Comfort, and Environment  

Seating and Security  

 The testing room must comfortably accommodate the number of testing stations placed in it.  Configure 

testing stations in such a way as to prevent the examinees from easily viewing the computer screens of nearby 

stations.    

 If there are no partitions between computer testing stations to restrict visibility, then there must be a 

separation distance of at least 5.5 feet (1.7 meters) from the center of one computer monitor screen to the 

center of the screen of any adjacent computer. If, after reviewing a test center’s lab layout, ETS determines 

that partitions are necessary, and will provide the required number of partitions to the test center.  

 In testing rooms where computer tables are at a 90-degree angle, do not seat examinees next to each other in 

the connecting corner. The 5.5-foot (1.7 meter) minimum distance must be maintained.    

 At each testing station, position the computer monitor, keyboard, and mouse properly for ease of use without 

strain.   

Comfort and Environment  

Ensure that testing rooms are appropriately heated or cooled, adequately ventilated, and free from distractions.  

 Use lighting that enables all examinees to read their computer screen in comfort. There should be no shadows 

or glare on computer screens or writing surfaces.   

 Ensure that testing rooms are quiet throughout all test administrations. When testing is in progress, do not 

conduct other activities in or near the testing room that would disrupt the standardized testing environment.   

 

Other Physical Requirements  
 Restrooms should be located near the testing room and should be easy to find. Post directional signs if 

necessary.  

 Have a telephone with access to an outside line available to staff at all times for use in calling for support, 

reporting irregularities, or tending to other emergencies.   

 Ensure that Internet connectivity is established and maintained to allow for the delivery of examinations.  
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 Remove from the room any written materials, other than testing station seat numbers.  

 Use facilities that meet local and national accessibility laws, such as the “Americans with 

Disabilities Act” (ADA) in the United States, and equivalent laws (if any) outside the United 

States. Building, testing rooms, and restrooms must be accessible to people with disabilities, 

including wheelchair access.  

 
Policies and Regulations  
 

Prohibited Items  

Use of the following items in the testing room is strictly prohibited.   

 Backpacks, fanny packs  

 Bags  

 Books, pamphlets and dictionaries  

 Briefcases  

 Calculator watches and watch alarms (especially those with flashing lights and alarm sounds).  

 Calculators  

 Cellular or other telephones  

 Digital watches (wrist or pocket)  

 Examinee-provided keyboards  

 Food or beverages  

 Any form of tobacco or tobacco products, alcoholic beverages, illicit drugs  

 Hats and headwear (unless by religious requirement) – See “Additional Security Procedures” on page 1-5.  

 Any writing utensil (except as provided by the test center)  

 Listening devices, personal stereos, radios with headphones, recorders  

 Non-medical electronic devices (laptop computers, digital assistants)  

 Outerwear (coats, jackets, etc.)  

 Pagers (beepers), BlackBerry devices  

 Papers of any kind  

 Purses, wallets  

 Copying and photographic devices  

 Slide rules, rulers, compasses, protractors  

 Stencils, colored overlays  

 Transmission or receiving devices  

 

Inform examinees who arrive at the test center with prohibited items that they are not allowed to bring them into the testing room. 

However, if examinees do not have access to a safe place to leave such items, e.g., a car or locker, they may, at the discretion of 

the TCA, place them in their pockets or handbags or under their desks. Outerwear (coats, jackets, etc.) may be hung on the back 

of the examinee’s chair.   

Before beginning the test, the test center personnel must ensure that examinees have all electronic devices – including cell 

phones, BlackBerry devices, beepers, and alarm watches and the like – turned off or set to silent mode and put away. These 

devices are not permitted on the testing surface at the workstation.  

Test center personnel should not accept responsibility for holding or safeguarding examinees’ personal possessions.  

Remind examinees to keep their identification (ID) with them at all times.  
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Non-Prohibited Items  

 Personal ID documents  

 Devices permitted by the testing accommodations status of the examinee  

Misconduct  

Because order as well as security must be maintained at the test center, the TCA has the authority to dismiss an examinee for 

misconduct. In certain cases, however, you may be reluctant to do so for fear of embarrassment, disturbance to other examinees, 

or physical reprisal. Dismiss when warranted, but use your judgment in handling each situation.  

Test center personnel must warn any examinee engaging in misconduct to stop his/her behavior.   

Inform examinees who are misbehaving that they will be asked to leave the test center if the misconduct persists. If, after a 

warning, the behavior persists, the TCA must dismiss the examinee and complete a detailed Irregularity Report regarding the 

incident.  

If the examinee is in the testing room, the TCA should attempt to resolve the problem without disturbing other examinees.   

The TCA should dismiss any examinee who continues to engage in misconduct and does not heed warnings. Complete a detailed 

Irregularity Report describing the incident (see Chapter 4:  Non-Technical Irregularities and Exceptional Situations).  

The following behavior is considered misconduct:  

 Giving or receiving assistance of any kind, talking to another examinee, hand signals, use of notes.  

 Using any prohibited items listed in “Prohibited Items” above.  

 Attempting to take an examination for someone else.  

 Failing to follow test regulations or instructions of administrator.  

 Causing a disturbance of any kind.  

 Removing or attempting to remove test questions and/or responses (in any format) or notes about test content 

from the test center.  

 Tampering with the operation of the computer or attempting to use it for any function other than taking the 

test.  

 

In Case of Violations   

If, in the judgment of the TCA, attempting to remove an examinee would create a disturbance to other examinees or 

result in a potentially threatening situation, the TCA may permit the examinee to complete testing but must submit a 

detailed Irregularity Report regarding the incident by e-mail to TOEICTech@ets.org.  

If the individual causes a serious disturbance and will not leave the test center, the TCA should call the police or other 

local authorities.  

Make certain to retain any materials related to events..  

For additional information, see “Chapter 4:  Non-Technical Irregularities and Exceptional Situations.”  

Requests for Media Coverage  

Testing is a subject of general interest, and test administrations may attract the attention of news media.   

Under no circumstance may reporters or photographers be admitted to a testing room or have access to examinees 

inside the test center.   

If media representatives are present at the test center during a test administration, the TCA must keep them out of the 

sight and hearing of examinees until all examinees have completed testing. It is imperative that their presence not 

distract or disturb examinees.   
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Ask members of the media to limit their coverage of a test administration to interviews with examinees (with their 

consent, of course) after test administration and away from the test center, and submit an Irregularity Report.   

All inquiries from news media must be referred to ETS External Relations at 1-609-683-2803.  

Examinee Complaints  

Examinees should be encouraged to contact t ETS if they have concerns, comments, or complaints about any aspect of 

the test administration in which they participated, including conditions under which they took the test. Examinees can 

contact TOEIC Services by e-mail at TOEIC@ets.org.  

Observers  

Test center observers authorized by ETS may visit test centers to evaluate the performance of the test center and ensure 

that the centers’ facilities and procedures comply with established policies and requirements. Advance notice of an 

observation may be provided, or it may be unannounced.   

During an observation, the observer may suggest modifications to your test center procedures to help alleviate any 

problems that have occurred, and test administration staff may have the opportunity to raise questions, make comments, 

and seek advice from the observer. ETS will work with test centers to ensure that any necessary corrective action is 

taken.  

Test Security  

ETS maintains strict exam administration and exam security procedures designed to prevent any testing irregularities or 

improper conduct that would give any student an unfair advantage. It is essential for TCAs and proctors to perform the 

administrative and security procedures described in this manual to ensure that all test administrations are uniform 

and fair and that the security of the test materials is not compromised.  

Test Materials and Equipment Security  

Security of test materials is critical. From the moment a test is launched until the examinee completes the test and is 

dismissed from the test center, the TCA is responsible for ensuring the test’s protection from loss or unauthorized 

access and preventing an examinee from having either an unfair advantage or disadvantage.   

These responsibilities include:  

 

  Ensuring that all examinees are authorized to test and that the person taking the test is the person authorized 

to take it.   

 Making certain that the following requirements are met:  

o No unauthorized visitors may be permitted into the test center or testing rooms.  

o No examinee has access to test materials before the administration.  

o No one, except examinees as they take the test, reads the content of the test at any time (this 

includes all members of the test center staff).  

o Test center staff members may view the test screen only if the complaint is regarding a technical 

problem (i.e., formatting, font size too small, part of question off screen, etc.).  

o No one copies, photographs, or records any test questions or takes secure test material from the test 

center.  

o No one inspects computer-displayed items or secure paper test material at any time, except for 

examinees as they test.  

o Test center staff members may not inspect the content of test materials during an examinee’s report 

of a specific defect.  

o Test center staff members may not read individual test questions if an examinee reports flawed 

questions.   
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 If an examinee reports problems with a question(s), the TCA should file an Irregularity Report documenting the 

complaint and advise the examinee to address the complaint with ETS.  

 At no time should the content of a question be placed in an Irregularity Report. Refer to the test and the question 

number only.  

 Report to ETS via the Irregularity Report any potential compromise of test data or materials before, during, or after 

testing process and any and all unusual testing circumstances.  

 

Additional Security Procedures  

Perform the following security measures when checking in examinees:  

 Visually inspect any heavy-framed glasses or large jewelry to ensure no wires are hidden. Request the 

examinee to remove his/her glasses and hold them out in front of you for inspection. Do not physically 

handle the items yourself. If wires are found, the TCA must dismiss the examinee and not let him/her take the 

test.  

 Be aware that lanyards (cords that allow glasses to hang around the wearer's neck) can be used to conceal 

wires.  

 Be aware that loose-fitting apparel can conceal wires and other cheating devices. Do not ask an examinee to 

remove clothing, but be vigilant in your proctoring duties to ensure that no devices were hidden and used 

during the exam.  

 Important:  Weapons of any kind are prohibited at the test center. Only law enforcement personnel acting in 

an official capacity (not as an examinee) may carry their weapons in the test center. The TCA must file an 

Irregularity Report each time a weapon is brought to the center.   

 

Head Coverings Worn for Religious or Cultural Purposes  

Typical head coverings may include hats, turbans, scarves, and yarmulkes.   

 All head coverings that are worn for religious or cultural purposes are allowed in the testing room.   

 Visually inspect head coverings for hidden wires, notes, etc. or any item that might be used during the test.  

Important:  Do not ask the examinee to remove the headgear.  

 If a test center staff member sees an examinee either remove or put anything into the head covering, the TCA 

should request to inspect the item. This constitutes examinee misconduct and must be reported in an 

Irregularity Report as a breach in test security.   

 If any video or recording devices are discovered, contact ETS Technical Support immediately.  

ETS Scores and Test Results Integrity Policy  

ETS must report scores that accurately reflect the performance of the examinee. For this reason, ETS maintains test 

administration and test security standards designed to ensure that all examinees have the same opportunity to 

demonstrate their abilities and to prevent some examinees from gaining an unfair advantage over others because of 

testing irregularities or improper conduct.   

ETS reserves the right to cancel any test result if the examinee engages in improper conduct.   

ETS also has the right to question any test score when validity is in doubt because the examinee may have obtained the 

score unfairly.  
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Test Center Staff  

Qualifications  

All TCAs and proctors must:  

 Be an employee 

 Be at least 18 years of age.  

 Preferably, be able to read, write, and speak English.  

Conflict of Interest  

To avoid a conflict of interest or appearance of any impropriety, test center staff members must:  

1. Not be involved in any test preparation or coaching activity whose purpose is to address the content of secure ETS 

tests.    

2. Not administer, or provide access to, any ETS test to a member of his or her household or any immediate family 

member, or any third party known to them who has not followed standard test registration procedures.   

3. Not handle secure test materials for administration of an ETS test to a household or immediate family member or any 

third party known to them, such as a fellow employee, who would obtain advantage or benefit as a result of the 

administration or handling of materials.  

4. Not register for a test without approval  

5. Not administer or provide access to any test to an employee of a test center where he or she works.  

6. Not provide access to any examination or proprietary test delivery software to any third party except those who are 

registered to take the test under secure testing conditions.  

7. Legal action may be brought against test center staff for failure to adhere to these conditions. Additionally, ETS 

reserves the right to invalidate test results of a test center staff member or third party should these guidelines be 

violated.   

Examinee/Proctor Ratio  

Each test center is required to provide a TCA and proctors in the following proportions, per testing room:  

 1–25 examinees require 2 staff members (1 TCA and 1 proctor)  

 26–40 examinees require 3 staff members (1 TCA and 2 proctors)  

 41–80 examinees require 4 staff members (1 TCA and 3 proctors)    

 

Responsibilities  

Each test center requires a TCA, who is responsible for the overall test administration, including the following:  

 Ensure that the testing stations have been prepared for test delivery.    

 Assign proctors, provide them with specific information about test administration procedures, and supervise 

their work.  

 Complete check-in of examinees  

 Ensure the security of the test center   

 Write Irregularity Reports  

 Coordinate activities with the proctor(s)  

 Ensure that the testing room is supervised at all times.  
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Each test center requires one or more proctors, whose responsibilities include the following:  

 Before the exam, familiarize themselves with the administration, test security, and irregularity 

procedures in this manual.  

 Assist the TCA with preparing the testing stations  

 Monitor the testing room to maintain security  

 Report any irregularities to the TCA  

 A proctor must not perform any duties other than proctoring the test while a testing session is in 

progress.  

 

At least one test center staff member must be present within the testing room at all times during all testing sessions.  

Humanizing the Test Administration  

It is important to remember that when an examinee comes into a test center, the test s/he is about to take may determine 

the rest of the examinee’s career. Most examinees have spent many hours studying, and some will not be at their best 

during the test.    

All this places the TCA in a very special position to conduct every administration in an empathetic way. Because the 

TCA’s behavior will set the tone for the test center, he or she must follow the guidelines below:  

 

Test center staff members must:  

  Greet examinees courteously to ease their anxiety.   

  Use appropriate behavior to show examinees they are welcome and to make the testing experience less 

threatening.   

  Acknowledge unexpected problems (such as locked doors, extreme room temperatures, or computer 

problems), and let examinees know that efforts are being made to correct the situation as quickly and effectively as 

possible.  

  At check-in area, inform examinees about:   

  Location of fire exits and any information related to safe evacuation of the building   

  Location of restrooms   

  Prohibition against eating, drinking, and using tobacco and alcohol in the testing room   

  Smoking regulations in the rest of the building  

  Prohibition against leaving the testing facility during the test or breaks  

  Do their best to answer any examinee questions, but advise examinees that test center staff members only 

proctor the tests and do not have knowledge of test content.  

  Treat all examinees in a fair and courteous manner, regardless of age, gender, ethnicity, etc.  

  Refer examinees who wish to discuss test results to ETS.   

 

If an examinee is upset, it is critical that any comforting gesture made by the TCA be verbal. A TCA must never make 

physical contact with an examinee. It could be misinterpreted, or it may make examinee feel uncomfortable.  
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Chapter 2:  Before Test Day  
 
Preparing Testing Stations for a Center’s First Administration  
 

The following actions must be completed to prepare the testing stations before a test center’s first 

administration of the TOEIC Speaking and Writing tests via the Web-based delivery platform.   

  
Action  For instructions, see…  

1. Ensure that all computers meet the hardware and 

software requirements.  

Appendix A:  Hardware, Software, and 

Browser Configuration Requirements  

2. Configure Internet Explorer.  Appendix A:  Hardware, Software, and 

Browser Configuration Requirements  

3. Install the audio browser and Windows Media 

Player.  
Appendix B:  Software Installation 

Procedures  

4. Install headsets, and run a system check of the screen 

settings and the audio recording and playback 

functions.  

Appendix C:  Headset Procedures, 

System Check, and Audio 

Troubleshooting  

5. Run a center/computer check.  Appendix D:  Center/Computer Check  

6. Perform the audio quality verification procedure.  Appendix E:  Audio Quality 

Verification   

7. If the number of Estimated Users determined by the 

center/computer check is less than the number of 

examinees you plan to test simultaneously, run a stress 

test.  

Appendix F:  Stress Test  

  

Preparing Testing Stations for Subsequent 
Administrations  
 

Depending on how frequently a center conducts administrations of TOEIC Speaking and Writing tests via the Web-

based delivery platform and whether the setup of the computers may have been changed in the interim, it may not be 

necessary to repeat all of the testing station preparation steps listed above for every administration. For example, it is 

not necessary to reinstall the audio browser unless it has been uninstalled since the previous administration.   

 

Before each administration, it is recommended to complete the following steps:  

 Run the system check (see “Appendix C:  Headset Procedures, System Check, and Audio 

Troubleshooting”) to verify the screen resolution and audio recording/playback functions.  

 Run a center/computer check (see “Appendix D:  Center/Computer Check”) to verify the center’s ability to 

deliver the number of tests planned for the current administration.   
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Chapter 3:  Test Day Activities  
  

Preparation Before Examinees Arrive  
 
Opening the Test Site on Test Day  
 

On test day, before examinees arrive, the TCA will perform procedures for opening the test center and preparing the 

facilities, computers, and other materials. No examinees should be checked-in until the following preparations have 

been completed.  

1. Registration Materials:  Bring out all necessary materials for the test administration (e.g., roster and 

Authorization Number Forms).  

 

2. Testing Room Setup:  Make any necessary adjustments to the configuration of the testing room (e.g., 

setting up partitions, removing maps and charts).  

 

3. Testing Station Setup:  Perform the following steps at each testing station:  

a. Open Internet Explorer to the testing login page, http://toeicsw.ets.org.   

 

b. Confirm that the audio browser is installed by clicking the “Download Audio Browser” link.   

 If the audio browser has been installed successfully, you will be directed to a screen 

resolution test and an audio/microphone setup check. (See “Appendix C:  Headset 

Procedures, System Check, and Audio Troubleshooting.”)   

 If a prompt appears that says you do not have the audio browser installed, follow the 

prompts to download it. The download procedures are described in “Appendix B:  

Software Installation Procedures.”  

c. Verify that a headset is plugged in and set up properly.    

 

d. Click the Center/Computer Check link from the login page (http://toeicsw.ets.org) to confirm 

that the bandwidth is sufficient and that each testing station is still capable of delivering the tests. 

Follow the directions and screen shots in “Appendix D:  Center/Computer Check.”  This check 

should have been done prior to the administration day, but should be performed again to confirm 

computer specifications.    

 

e. Prepare two or three extra testing stations to be used in case technical difficulty makes it 

necessary to re-assign and re-start an examinee’s test on a different computer. Note:  If a technical 

difficulty occurs and you need to move an examinee, the current testing station must be shut down 

before restarting a test with the same authorization number on another computer.  

4. Direction Signs:  When possible (and as appropriate for the facility), provide signs to direct examinees to 

the check-in location.  
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Identification (ID) Requirements  
 
One of a TCA’s most important responsibilities is to protect the integrity of the tests. TCAs have the authority and the 

responsibility to prevent unauthorized admittance to the testing room. The TCA must determine if the ID matches the 

individual presenting it and has not been altered or falsified.   

 

Acceptable Forms of TOEIC ID  
 

Test Location 
or Examinee 
Status  

Primary ID  
(Must Present One of the 
IDs from this Column)  

Supplemental ID  

(If Required in Addition to the Primary ID; NOT a 
Substitute for Primary ID)  

Testing Within 

Country of 

Citizenship  

Must present one of the 

following ID documents:  

• Passport with photograph and 

signature  

• Driver’s license with 

photograph and signature  

• State or province ID with 

photograph and signature  

• National ID with photograph 

and signature  

• Military ID with photograph 

and signature  

• Employee ID with 

photograph and signature    

If the examinee’s primary ID document does not contain 

the examinee’s signature*, the examinee has the following 

options:  

• The examinee may present TWO current primary IDs with 

a photo.  

• The examinee may present one of the following 

supplemental ID documents in addition to the primary ID. 

The supplemental ID must contain the examinee’s photo 

and signature and must not be expired.  

Supplemental ID Documents:  
  A government-issued ID document that has not expired 

(including but not limited to passport, driver’s license, 

state/province ID card, national ID, or military ID)  


• The examinee may choose to sign the primary ID (with a 

permanent ink pen or marker) in order to meet the 

requirement.*  

 

If the examinee’s primary ID document does not contain 

the examinee’s photo, the examinee must present one of the 

following supplemental ID documents in addition to the 

primary ID. The supplemental ID must contain the 

examinee’s photo and signature.  

 Supplemental ID Documents:  
•  A government-issued ID document that has not expired 

(including but not limited to passport, driver’s license, state 

ID card, national ID, or military ID)  

•  Student ID  
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Test Location or 
Examinee Status  

Primary ID  
(Must Present One of the IDs from this 
Column)  

Supplemental ID  
(If Required in Addition to the 
Primary ID; NOT a Substitute for 
Primary ID)  

Testing Outside Country 

of Citizenship  

Must present one of the following ID 

documents:  

• Passport with photograph and signature  

• Employee ID with photograph and signature  

Exception for citizens of European 

Union/Schengen Zone countries testing 

within another European Union or Schengen 

Zone country:    

• If passport is not presented, a national or 

European identity card is acceptable. The ID 

card must contain a recent, recognizable 

photo, date of birth, and examinee’s signature.   

 If it does not contain all of these items, the 

examinee must also present another document 

from the list of supplemental ID documents 

above.  

If the passport is not written in English 

language letters, the examinee must 

present a second document from the 

supplemental ID list below. The 

supplemental ID must also contain a 

recent, recognizable photo and must be in 

English.  

If the passport does not contain the 

examinee’s signature*, the examinee 

must either sign the passport or present a 

second document from the supplemental 

ID list below that does contain a 

signature.  

Supplemental ID Documents:  
• A government-issued ID document that 

has not expired (including but not limited 

to passport, driver’s license, 

state/province ID card, national ID, or 

military ID)  

• Student ID  

Examinee Status:   

•  Refugee  •  On active 

military service outside 

his/her own country and 

does not have a passport 

•  Unable to meet the 

specified ID 

requirements for any 

reason  

 N/A  

*If the passport or primary ID document does not contain the examinee’s signature, but is otherwise a valid passport/ID 

document, the examinee has the option either to sign the passport/ID document in permanent ink during check-in or to 

present additional ID bearing his/her signature. If the examinee chooses to sign the passport/ID document at check-in, 

s/he must use a pen or marker with permanent, non-erasable ink; in that case, there is no need for him/her to present an 

additional ID document. On passports on which the traditional signature page (inside left cover) is covered with a 

laminate, examinees can sign the facing page (the first right-hand page inside the passport).  

 

Unacceptable Forms of ID for TOEIC Tests  
Unacceptable forms of ID include, but are not limited to:  

 Any expired ID  

 Draft classification card  

 Credit/debit card of any kind  

 Social Security card  

 Learner’s permit or any temporary ID document (e.g., driver’s license)  

 International driver’s license  

 International student ID  

 Notary-prepared letter or document  

 Birth certificate  

 Any photocopied document  
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Checking In Examinees  
 

Important:  Examinees are instructed to report 30 minutes before the scheduled start time. No test should be started 

more than 30 minutes before the scheduled start time.  

 

At the check in desk, the TCA will have a roster of examinees and each examinee’s individual Authorization Number 

Form, which includes the examinee’s authorization number, first name, last name, date of birth, administration date, 

and a signature box.   

 

The TCA should complete the check-in steps listed below before allowing each examinee to enter the testing room:  

1.  Greet the examinee.  

2.  Check the examinee’s identification. The TCA must ask for identification from every examinee.  

 

a. The examinee must present a valid passport or other acceptable and valid ID containing all of the 

following items:  

 The examinee’s name as given when the appointment was made  

 A recent, recognizable photograph of the examinee  

 The examinee’s signature  

 See “Identification (ID) Requirements,” on page 3-2.  

 

b. Make sure the photo looks like the person presenting it. If the TCA is uncertain that the ID 

matches the person presenting it, the TCA should ask to see a second form of ID.  

 

c. Compare the name and date of birth on the examinee’s ID to the information on the examinee’s 

Authorization Number Form. If corrections to the spelling of the name or the date of birth are 

needed to make the registration match the ID, note the corrections on the Authorization Number 

Form.  

d. Do not admit any examinee who cannot produce the required ID. If you must turn away an 

examinee for unacceptable ID, complete an Irregularity Report and e-mail it to 

TOEICTech@ets.org  after the administration.  

e. If, to avoid a serious disturbance, you must admit an examinee without acceptable ID, file an 

Irregularity Report, and advise the examinee that scores will not be reported and will be canceled.  

 

8. Provide the examinee with a writing utensil and his or her Authorization Number Form.  

a. Inform the examinee that the information on the Authorization Number Form will be printed on 

the score report. Ask the examinee to verify the spelling of the name and the date of birth shown on 

the form and then sign the form.  

b. Collect the writing utensil from the examinee.   

c. Tell the examinee to keep the Authorization Number Form. It will be collected in the testing 

room after the examinee has used the authorization number to login to the test.    

 

4. Return the ID to the examinee.  

 

5. Escort the examinee to the assigned testing station.   

a. Tell the examinee not to touch the keyboard until the entire group is given instructions to do so. 

All examinees must be seated before the login process will begin.    

b. Tell the examinee about adjustments that can be made to the testing station equipment such as 

repositioning the monitor to accommodate use of bifocals, repositioning keyboard, adjusting chair 

height, etc.  

6. After all examinees have been checked in and seated, continue with the steps below for “Starting the Test.”  

mailto:TOEIC@ets.org
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Starting the Test  

Before performing the steps below, the TCA must perform the check-in procedures shown in the previous section, 

“Checking In Examinees.”  

 

Note:  Examinees will need to enter their Authorization Number a total of three times to complete the login steps 

described below.  

Monitor examinees during the login process to make sure that each examinee is in possession of his or her own 

Authorization  

 

Number Form at all times and logs in with this assigned authorization number only.  

 

1. Inform examinees that the group will complete the login process together and individuals are not permitted 

to jump ahead. Emphasize to examinees that the test center staff reserves the right to cancel the examinee’s 

test if the examinee begins testing before his or her Authorization Number Form has been collected.  

 

2. Ensure that all examinee workstations are at the URL http://toeicsw.ets.org  which displays the Candidate 

Login screen:  

  
The examinee begins by entering his or her Authorization Number.  

  

  

3. Tell examinees to enter the Authorization Number shown on their Authorization Number Form into the 

box provided on the screen, click Submit, and stop when the next screen appears:  

  
The examinee re-enters his or her Authorization Number.  

  
4. Tell examinees to enter their Authorization Number again for confirmation as instructed on the screen, and 

click Submit.   

 The Welcome screen will appear and will display the name of the test the examinee is about to take:  

  

  

5. Tell examinees to click the Click Here to Continue button on the Welcome screen.   

 The Profile screen will appear:  

  
The examinee enters his or her Authorization Number for the third and final time on this Profile 

screen.  

  

6. Tell examinees to enter their Authorization Number on the Profile screen, click Submit, and 

stop at the Start a New Test screen. Tell them not to click the Start Online button yet.   

  

  7. Collect the Authorization Number Form from each examinee individually.   

a. When collecting the forms, check each form against the examinee’s ID to ensure that 

examinees are using their own authorization numbers.  

b. If an examinee does not return an Authorization Number Form, do not allow that 

individual to take the test.  

 

8. After collecting the examinee’s Authorization Number, tell the examinee to click Start Online 

to begin the test.   

http://toeicsw.ets.org/
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Format and Delivery of the Test  
 

The TOEIC Speaking and Writing tests are delivered as two separately-timed sections in the following order:    

 

1.  Speaking  
Content: 11 questions   

        Time: approximately 20 minutes   

 

2.  Writing  
         Content: 8 questions   

         Time: approximately 60 minutes   

 

In the Writing test, examinees must type their responses on the computer. They are not allowed to submit handwritten 

responses.  

There is no tutorial. However, instructions for using the testing tools are available by selecting the Help tool at any 

time. Selecting Help does not stop the testing time.  

 
Test Session Screens  
 

After clicking Start Online, an examinee will proceed through the following sequence of screens:  

 

1. View a logo and copyright screen:  

   

  

2. View a screen showing the title of the examination.  

 

3. Read a Test Center Regulations screen:  

   

  

4. Read a screen titled If You Need the Administrator:  

   

 

5. Read and confirm a Confidentiality Agreement:  

   

6. Adjust and verify the audio and microphone settings by following instructions on a series of screens. First, 

the examinee will have the opportunity to adjust the volume of the headset:   

   

  

7. Then the examinee will follow instructions to record and play back a spoken response to a sample question 

to adjust the microphone to the examinee’s voice:  

  

8. Once the headset and microphone have been set up correctly, the examinee may move on and begin the 

test.   

 Note:  If an examinee raises his or her hand to report a problem with the headset or microphone, refer to 

“Appendix G:  Handling and Reporting Technical Problems.”  

  

9. After completing the Speaking test, the examinee will continue on to the Writing test.  

 

10. When the examinee has completed the Writing test, the Use of Response Data screen will 

appear. The tests are not considered complete until the examinee answers the question on this 

screen, clicks the Next button, and clicks through the next two screens to reach the 

Completed Tests message. If this is not done, the tests are considered “incomplete” and the 

responses will not be scored.    
   

   
The examinee clicks Continue to go on.   
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Again, the examinee clicks Continue to go on.   

   
  

11. The Completed Tests screen shown below is the final screen. Before allowing an examinee to leave the 

testing room at the end of the test, a test center staff member should check the examinee’s testing station to 

make sure the Completed Tests screen is displayed. For additional information, see “Ending the Test 

Session” on page 3-15.  

   
Test center personnel should confirm that this Completed Tests screen is displayed before the 

examinee leaves the testing room.   
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Monitoring the Testing Room and Handling  
 
Irregularities  
 

At least one test center staff member must be in the testing room at all times while testing is in progress.   

 

A test center staff member must physically walk through testing room at frequent intervals to monitor examinee 

behavior and provide assistance as follows:  

 

 Prevent or resolve, in a fair and constructive manner, any incidents of improper examinee conduct. 

Be sure to explain any irregularities or unusual situations on an Irregularity Report.  

 Assist examinees who have questions or problems during the test.  

 Do your best to answer questions about testing procedures and directions for using the computer.   

 Do not answer questions about specific content of the test or answers to any test questions.   

 Keep conversation in the testing room to an absolute minimum.  

 Once a test has started, do not move an examinee to a different testing station unless technical 

problems prevent the examinee from completing the test at the original testing station.  
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Unscheduled Breaks  
 

There are no scheduled breaks during the TOEIC Speaking and Writing test. However, examinees are allowed to take 

unscheduled breaks to leave the testing room briefly during actual testing time to go to the restroom or take medication.  

 

Use the following procedures and guidelines for unscheduled breaks:  

 

 Remind examinees that test time continues to run during unscheduled breaks and they 

will not be allowed extra testing time.  
 Important:  Do not permit TOEIC examinees to take unscheduled breaks when a speaking item is 

playing or when a test instructions screen is displayed.  

 Examinees are not permitted to leave the test center vicinity during the test session. 

 Examinees are not permitted to use phones, study materials, or other prohibited items during 

breaks.  

 After an unscheduled break, ensure that the examinee returns to the correct computer and does not 

bring any prohibited items into the testing room.  

 If an examinee takes two or more unscheduled breaks, the TCA must file an Irregularity Report 

indicating the number of breaks taken and the reason, if known.  

 
Ending the Test Session  
 

Use the following steps to end the test session, dismiss examinees, and gather information needed to update the 

registration file:  

 

1. Ensure that all computers display the “Completed Tests” confirmation screen.  

2. Make sure all Authorization Number Forms have been collected. Do NOT allow examinees to leave the 

testing room with them.  

3. The TCA or Proctors should remind examinees to retrieve any personal belongings that may have been 

stored under the computer desk.  

4. Make a note of the following information and be email it to AMIDEAST  

(english4success@amideast.org)  

 The names and authorization numbers of “No show” examinees  

 Alternative authorization numbers that were used because of technical difficulty.  

 Corrections to examinee information (name misspellings, birth dates, etc.)  

5. Return the computers to their original settings if any changes were made.  

6. Ensure that headsets are returned to the appropriate storage area.  

7. Store all Authorization Number Forms in a safe place for  administration records. Keep the forms for six 

months; then destroy them.  

8. Check the testing room for abandoned personal items.  
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Post Administration Activities  

 

Chapter 4:  Non-Technical Irregularities and 
Exceptional Situations  
 
Importance of Irregularity Reports   
  Irregularity Reports are admissible evidence in a court of law.  

  Some irregularities may not involve examinees, but should still be reported in an irregularity report.  

  Facts that seem of little consequence at the time may later assume considerable significance when ETS must decide 

whether further action is required.  

  ETS review all Irregularity Reports submitted and will take appropriate action. It is important to write Irregularity 

Reports in clear, objective, professional verbiage that resolves all questions.  

  ETS relies on the TCA to be responsible for all aspects of test administration. The TCA must handle any emergency 

or exceptional situations at the test center.  

  ETS will support a TCA’s actions if they are consistent with established ETS policies and procedures. A TCA’s 

actions must be reasonable, sound and designed to assure test validity, a satisfactory testing environment, and test security.  

  The TCA should report incidents as soon as practical after they occur. The TCA should ask a Proctor to monitor the 

testing room while they (the TCA) handle test center situations and complete Irregularity Reports, if needed.  

 

Reporting Non-Technical Irregularities  

 When creating an Irregularity Report, remember that each report should tell a complete story of the incident. 

Irregularity Reports must be complete, professional, and resolve questions. Document all actions taken so that others reading the 

report can determine exactly what took place. Include the information described below on the Irregularity Report.  

  When completing an Irregularity Report, enter all applicable identifying information:  

  Administration date  

  Country  

  Examinee name  

  Authorization number  

  Institution/company name  

  Test center name and location  

  Time of incident  

  TCA name  

  Workstation ID  

  Describe what happened in detail:  

  What took place:  Describe the situation and problem as completely as possible.  Note: Do not state or describe the 

content of any test item when completing an Irregularity Report. This will result in a compromise of security of the test question.     

  When it happened:  If possible, give exact time of day and time showing on computer screen if it is relevant to the 

irregularity  

  Where it happened:  Check-in area, hallway, testing room, etc.  

  Relevant personnel:  Include the names and telephone numbers of all personnel who might provide relevant 

information regarding who witnessed the incident. (This would apply to misconduct cases, injury to an examinee, or other any 

unusual incident at the test center.)  

  Describe the resolution:  

  The amount of time it took to resolve the problem.  

  Details of all actions taken and by whom (e.g., TCA).  

  For security breaches or examinee misconduct, include the following additional information:  

  Names of other examinees involved, if any.  

  Names of test center employees who witnessed the incident.  

  Itemize any unauthorized materials involved in the incident - include the manufacturer and model #.  

  Indicate if the test center is still in possession of these materials.  

  Describe how the materials were being used.  

  Describe all activities that were observed.  
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  Describe the actions taken to resolve the situation.  

  State if it is believed that there was a breach in the security of the test questions or the results for the 

examinee.  

 

How to Act on Irregularities  
 

For any of the following actions, the examinee should be dismissed from the test center and a detailed Irregularity 

Report written. Remove the examinee and complete an Irregularity Report if examinee attempts to:  

  

  Remove test questions from the room.  

  Use prohibited aids.  

  Impersonate a scheduled examinee.  

  Tamper with the testing equipment.  

  Give or receive assistance from another examinee.  

  Cheat in any way.  

  Create a disturbance after a warning.  

 

Important: If an examinee threatens test center staff with bodily harm, call the local police and/or building security.  

Complete an Irregularity Report for all actions taken regarding any irregularity such as:  

 

  Emergency closing of the test center.  

  Equipment or test material theft or vandalism.  

  Any event that prevents an examinee from completing a test that has been started.  

 

  Any event that significantly disturbs the testing environment.  

  Any event that interrupts testing, although testing is successfully resumed (e.g., power outage, 

environmental problems).  

  Examinee takes repeated unscheduled breaks.  

  Examinee leaving testing room without permission, or due to illness.  

  Examinee creates a disturbance of any kind.  

  Examinee complains about any aspect of the testing process.  
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Facility Problems  
Situation  Procedure in the Testing Room  Irregularity Report 

Information/ Other 
Action  

Noise Problems  If a disruption occurs inside the testing room, 

or noise from outside the test center affects 

examinees, try to end the noise or disruption if 

possible.  

Describe the situation 

and the length of the 

disruption.  

Power Outages  When an electrical power outage occurs at the 

test center and power is immediately restored, 

the TCA will have to log each examinee back 

into the test by using the same authorization 

number that the examinee started the test with 

originally.   

If the power is not immediately restored, power 

off each testing station and other equipment 

until the power is again available.    

Ask examinees to wait at least 30 minutes for 

the power to be restored. After that time, give 

examinees the choice to either:  

• Wait in the center to resume the test.  

• Choose to be rescheduled to a makeup test.   

While waiting, examinees must remain in the 

testing room and must have no access to cell 

phones or other prohibited devices.  

See also “Power Outage During the Test” on 

page H-2.  

Describe the situation 

and actions taken, 

identify the affected 

examinees, and state 

whether they were able 

to complete testing.  

Emergencies  Emergencies include storms, floods, fires, fire 

drills, or other unusual activities that disrupt 

test administration and are beyond the control 

of test center staff. In an emergency the 

primary concern should be the safety of 

everyone present.  

• If necessary, evacuate everyone immediately.  

• If there is sufficient time, power off the 

examinees’ testing stations.  

• Lock the testing room door after everyone has 

exited.  

If the computers were powered off, and it is 

possible to return to testing room in a 

reasonable amount of time (as in the case of a 

fire drill), follow procedures to restart each 

computer and allow examinees to continue 

testing.  

If the computers were NOT powered off, and it 

is not possible to return to testing room in a 

reasonable amount of time, the testing session 

must be terminated because the computer will 

have continued to count down during the time 

examinees were away. 

Describe the situation 

and actions taken, 

identify the affected 

examinees, and state 

whether they were able 

to complete testing.  
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Possible Test Question Ambiguities or Errors  

Situation  Procedure in the Testing 
Room  

Irregularity Report/ 
Other Action  

Examinees report possible 

typographical errors, 

ambiguities in test questions, 

multiple correct responses, 

etc.  

Inform examinees that you will 

file a report about their concerns.  

File an Irregularity 

Report. State only the test 

section number and name 

and the item number. Do 

not copy the exact text of 

any test question. This is 

important in maintaining 

test security.  
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Examinee Behavior and Misconduct  

Situation  Procedure in the Testing Room  Irregularity Report/ 
Other Action  

Disruptive Behavior and 

Misconduct  

Because TCAs must maintain order 

as well as security at the test center, 

they have authority to dismiss an 

examinee for disruptive behavior or 

other misconduct. If an examinee’s 

behavior during testing disturbs 

others, and the TCA believes the 

disruption may prevent others from 

doing their best work, the TCA will 

do the following:  

 

• Warn the examinee that he or she 

will be dismissed if the disruptive 

behavior persists. The TCA should 

not engage in a confrontation.  

• If the examinee continues to be 

disruptive, the TCA may dismiss the 

individual from the testing room.  

• Dismissal is also warranted if, after 

receiving a warning from test 

administration staff, an examinee 

continues to engage in any other type 

of misconduct. (See “Misconduct” on 

page 1-3.)  

• In certain cases the TCA may be 

reluctant to dismiss an examinee for 

fear of embarrassment, disturbance to 

other examinees, or physical reprisal. 

The TCA should dismiss examinees 

when warranted, but they should use 

their best judgment in handling each 

situation.  

• When dismissing an examinee, the 

TCA must advise the person that 

failure to adhere to testing regulations 

after receiving a warning made the 

dismissal action necessary and that 

the dismissal will be reported to ETS.  

• If, in the judgment of the TCA, 

attempting to remove an examinee 

would create a disturbance to other 

examinees or result in a potentially 

threatening situation, the examinee 

should be permitted to complete 

testing.   

• If the individual causes a serious 

disturbance and will not leave the test 

center, the TCA should call the police 

or other local authorities. The TCA 

should be sure to retain any materials 

related to the events as ETS may 

request them. 

File an Irregularity Report.  
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Situation  Procedure in the Testing 

Room  
Irregularity 
Report/ Other 
Action  

Using a Prohibited Item in 

the Testing Room  

If the TCA observes that an examinee inside 

the testing room is using a telephone, 

personal digital assistant, or other prohibited 

item(s), the TCA should take the following 

actions:  

1. Record the time of the initial observation. 

If possible, have another test center staff 

member witness the misconduct.  

2. Call ETS office for authorization to 

dismiss the examinee.  

3. Dismiss the individual after receiving 

authorization. Inform the examinee that 

violation of testing regulations has made 

dismissal necessary and that the incident 

will be reported to ETS.  

4. Terminate the test by using the key 

sequence Shift+Ctrl+Alt+F10.  

Note: The TCA should take the above 

actions when the violation is first observed; 

do not give a warning or wait for a second 

violation to occur. You can turn off the 

testing station so that testing time stops 

while you handle the situation.  

File an Irregularity 

Report including the 

make and model of 

any electronic 

equipment used (if 

applicable).  

Using a Prohibited Item 

Outside of the Testing Room 

During a Break  

1. Warn the examinee that the activity is not 

permitted and it will be reported to ETS 

office.  

2. If the examinee violates the regulation 

again after the warning, warn them again.  

File an Irregularity 

Report.  

Late Arrival  A TOEIC Speaking and Writing tests 

examinee who arrives more than 30 minutes 

late must be turned away.  

  

Unscheduled Departure from 

the Test Site  

If an examinee leaves the test center before 

completing the testing process:  

• If an examinee leaves the center part way 

through the Speaking test, the TCA must 

allow the Speaking test to run until it times 

out. Then start the Writing test and click OK 

to move through it until time runs out. 

Answer No to the question on the Use of 

Response Data screen at the end of the test.  

File an Irregularity 

Report.  
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Situation  Procedure in the Testing Room  Irregularity 

Report/ Other 
Action  

 • If an examinee leaves the center after the 

Speaking test, advise them that they will 

receive zeros for the second test (Writing). 

Incomplete tests equate to zeros. The TCA 

must start the Writing test and click OK to 

move through the test until time runs out. 

Answer No to the question on the Use of 

Response Data screen at the end of the test.  

• If an examinee leaves the center part way 

through the Writing test, the TCA must click 

OK to move through the Writing test until 

time runs out. The TCA must answer No to 

the question on the Use of Response Data 

screen at the end of the test.   

 

Medical Emergency or 

Illness  

If an examinee becomes ill and must leave 

room temporarily, handle the situation the 

same as for an unscheduled break. Note the 

time examinee left and returned on the 

Irregularity Report.  

If an examinee must withdraw permanently 

from testing because of illness, follow 

instructions described in “Unscheduled 

Departure from the Test Site”. File an 

Irregularity Report.  

In case of serious illness or medical 

emergency:  

• Call a local emergency medical number.  

• Render whatever aid possible and make the 

examinee comfortable until help arrives.  

If other examinees 

are disturbed by the 

examinee’s illness 

and have lost 

testing time, file an 

Irregularity Report 

indicating all 

examinees affected.  
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Appendix A:  Hardware, Software, and  
 
Browser Configuration Requirements  
 
Minimum System Requirements   
 
 Operating System: Windows® 2000, Windows® XP, or Windows® Vista   

  Web Browser: Microsoft Internet Explorer 6 or 7   

  Monitor & Graphics Card: 1024x768 resolution, 65,536 colors (same as 16 bit color)  Note: Best 

results are obtained using a 17" CRT monitor.   

  Audio Capability: Sound card and non-USB headsets with non-voice activated microphones   

  Internet Connection: Broadband Internet connection required   

  Administrative Privileges on your Windows Operating System:  Required for software installation  

  Network Security Configuration:   

  Add “starttest.com”, “starttest2.com”, and “ets.org” as trusted domains   

  Unblock IP addresses 64.27.100.27, 64.27.64.232, 66.70.68.224, and 206.188.17.0/24   

  Open TCP/IP ports 80 (http) and 443 (https) outbound   

 

Note:  If necessary, consult your local network technician or administrator to ensure the above configuration.  

 
Software Requirements  
 Windows Media Player 9.0 (Windows 2000), 10.0 (Windows XP), or 11.0 (Windows Vista)   

 ITS Secure Browser, which is available at the test delivery website (see “Appendix B:  Software 

Installation Procedures”)  
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Browser Configuration  
 

Verify that Internet Explorer is configured as follows:  

  
IE Configuration  Required Setting   Details   Screen Shot  
Session Cookies   Enabled   Ensure that either Internet Explorer is configured to 

accept third party cookies, or session cookies are 

enabled in Tools>Internet Options> Privacy 

Tab>Advanced and the “Always allow session 

cookies” checkbox is selected.   

  

Encoding   Auto-select   On the Internet Explorer top menu, click 

View>Encoding and select Auto-Select.  
  

Pop-up Blocker   Disabled   Disable Internet Explorer’s pop-up blocker and 

other pop-up blockers.   
  

Browser Cache   Disabled   Ensure that Internet Explorer is configured to 

automatically check for a newer version of web 

pages in Tools>Internet Options>General 

Tab>Browsing History Pane>Settings.   

  

Active-X   Enabled   Ensure that Internet Explorer is configured to allow 

running of Active-X components in Tools>Internet 

Options>Security Tab>Security Settings for 

Internet Zone.  Note: You have to click on the 

Custom button to access these settings.   

  

Content  Auto complete turned off  Ensure that the AutoComplete options are turned 

off in Internet Explorer in Tools>Internet 

Options>Contents tab> AutoComplete 

pane>Settings. Uncheck the boxes for all options: 

Web addresses, Forms, and User names and 

passwords on forms and click OK to exit.  

  

Text Size   Medium   On the Internet Explorer top menu, click 

View>Text Size and select Medium.   
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Appendix B:  Software Installation 
Procedures  
 

The audio browser and Windows Media Player must be installed on each computer that will be used to 

deliver TOEIC S&W exams. Follow the procedures shown below to install these applications.  

Installing the Audio Browser  
 

The audio browser is a small software application that enables examinees’ spoken responses to be recorded during test 

delivery. It also hides other running programs and prevents examinees from accessing keys and programs that are not 

allowed during secure tests.   

 

The audio browser will be launched by the test and will be active only during test delivery, but it will remain installed 

on the computer. Therefore, you will not need to reinstall the audio browser before future test administrations on the 

same computer, unless the audio browser software has been removed intentionally or the computer has been re-imaged.  

 

Use the following steps to install the audio browser:   

 

1. Open Internet Explorer and go to the following URL: http://toeicsw.ets.org .   

2. Click Download Audio Browser.  

 Click Download Audio Browser.  

  
3. The screen will display a status message that indicates whether the audio browser is installed on this computer. If the 

message states that the audio browser is not installed, click the Click Here to Install link.  

Click the Click Here to Install link.  
  

3. The Audio Browser Setup screen will appear. It includes a list of Frequently Asked Questions about the audio 

browser. Feel free to read through the questions and answers.  

4. Click the Click Here to Install button. A File Download pop-up message will ask if you want to run or save the 

audio browser file. Click Run.    

  
When you Click Here to Install, the File Download box will pop up.  

Click Run.  

  
  If the computer is set to provide a warning message before opening files, the following Security Warning 

message will appear. This program is safe to run and will not harm your computer. If this message appears, click Run:    

 

If this message appears, click Run.  
  

5. The audio browser installation welcome screen will appear. Click Next.   

   
Click Next.  
  

6. A status bar will show the progress of the installation, which takes about five seconds. Then the screen shown below 

will confirm that the audio browser installation has been completed. Click Finish.   

  
Click Finish.  
  

7. To confirm that the audio browser has been installed successfully, return to http://toeicsw.ets.org and click 

Download Audio Browser. The status message should confirm that the latest version is installed as shown below.   

  

 Note:  Another way to verify that the audio browser is installed is to run a System Check; see Appendix C.  

http://toeicsw.ets.org/
http://toeicsw.ets.org/
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Installing Microsoft Windows Media Player  
 

Windows Media Player is a required software component for the TOEIC test. If it is not already installed 

on your computer, follow the steps below to install it:  

 

1. Go to http://toeicsw.ets.org and click the Technical Support link located on the right side.  

  

Click the Technical Support link.  

  

2. Click on Click Here to download Windows Media Player.  

   

Click this link.  

  

3. Select and download the version of Windows Media Player that is required for the operating system that 

is installed on your computer. Refer to Appendix A:  Hardware, Software, and Browser Configuration 

Requirements to determine the appropriate version.   

http://toeicsw.ets.org/
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Appendix C:  Headset Procedures, System 
Check, and Audio Troubleshooting  
 
Headset Procedures  

Headsets must be connected before the TOEIC Speaking and Writing tests are started at each testing station. The 

headset has two connectors that plug into the computer sound card plug-in jacks. One plug connects into the headphone 

jack, and the other plug connects the microphone.  

 

Note: DO NOT use headsets with USB connectors or voice activated microphones (refer to the technical specification 

sheet of the headset). If the computer has more than one sound card, ensure that the headset is connected to the working 

sound card.  

Care of Headsets  
 

1. Ear pieces must be wiped with alcohol after every use.   

2. Headsets must be stored carefully between exam windows. Wrap the cords around the headset to avoid 

tangles.  
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System Check/Audio Browser Download Confirmation  
System Check allows you to validate that a computer has the hardware and software required to deliver the test and 

confirm that the audio browser has been installed properly.   

 

To perform the System Check:  

 

1. Open Internet Explorer and go to the following URL: http://toeicsw.ets.org   

   
2. If you have not yet installed the audio browser software, click Download Audio Browser, and follow the 

installation procedures in “Installing the Audio Browser” in Appendix B:  Software Installation Procedures.  

3. If the audio browser is already installed, click System Check. The following screen will appear:  

4. Follow the instructions on the screen and click the Continue button.   

5. You will be prompted to check and adjust (if necessary) the following settings:  

a. Screen settings and picture quality  

b. Audio volume  

c. Audio recording and playback:   

  It is the staff member’s responsibility to confirm the sound quality of the playback. The system 

cannot evaluate the quality; it can only verify that a recording was played.   
  When the instructions tell you to record a 15-second response, begin your response by stating the name of 

your country and the workstation ID.  

 

Important:  It is critical to perform the audio recording and playback verification because it enables you to detect 

and resolve audio problems in advance. Unresolved audio problems can cause an examinee’s test to be unscoreable, 

and the examinee will not receive a score report. You should test the audio recording and playback on EACH 

computer for EACH administration.  
If there is a problem with microphone calibration or any other audio issue, refer to the following audio troubleshooting 

steps. If the problem still is not resolved, contact TOEIC Technical Support (TOEICTech@ets.org).  

http://toeicsw.ets.org/
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Audio Troubleshooting Tips  
 
Audio Browser Check Fails  
 

Problem: User cannot record their voice.   

Resolution: After plugging in the headset:   

1. Click the Start button in the bottom left corner of the screen.   

2. Point to All Programs, point to Accessories, and then click Windows Explorer.   

4. When the window opens, look under My Computer, and click on Local Disk (C :).   

5. Open the Program Files folder.   

6. Open the ITS subfolder.   

7. Open the Audio Browser subfolder.   

8. Open the Configure Audio Browser.exe file.   

9. When the window appears, make sure that Automatic is selected next to Configuration.  Note: You can also try 

selecting Default or Custom to see if they work better for your computer.   

10. Click Record, say something into the microphone, and click Stop.   

11. Click Playback. If the words you just recorded are played back, the problem is solved.  

 
Cannot Configure Audio Browser  

 

Issue: While trying to open Configure Audio Browser.exe the following error message is displayed: “Component 

'comctl32.ocx' or one of its dependencies not correctly registered: a file is missing or invalid”   

Resolution:   
1. Go to the following URL: http://www.nitropdf.com/kb/article.aspx?id=10031&cNode=3D8W4P   

2. Scroll down and look for Related external links.   

3. Click on Download comctl32.ocx.  

4. Choose Save or Save to disk and save the file, preferably to your desktop.   

5. Open Windows Explorer to view files and folders.   

6. Locate the C:\Windows\system32 folder on the Local Disk (C:).   

7. Copy and paste the comctl32.ocx file from the desktop to the System32 folder.   

8. Close all windows and restart the computer.   

  

http://www.nitropdf.com/kb/article.aspx?id=10031&cNode=3D8W4P
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Appendix D:  Center/Computer Check  
 

The center/computer check is an automated series of tests to determine computer test readiness:  

  

  The operating system and certain settings are checked to verify that they meet the requirements for test 

delivery.   

  Upload and download speeds are tested to determine whether the Internet bandwidth currently available to 

the computer is sufficient for testing.   

  Based upon the bandwidth available during the check, an estimate is provided of the number of users that 

can test concurrently in a lab of computers having the same specifications as the computer tested.   

 

Running the center/computer check is a quick, easy process, which you begin by going to the TOEIC testing website 

and clicking the Center/Computer Check link. After you enter some required information and select to run the check, 

the automated series of tests will be performed and the results displayed to you.   

 

Some of the tests simply collect information; others compare the information to a set of system requirements and 

determine if the computer meets the requirements. These tests are either Pass/Fail or Pass/Warn. The system passes if 

all Pass/Fail tests are passed, and fails if one or more Pass/Fail tests are failed. The Pass/Warn tests are not used as part 

of the overall Pass/Fail status but are helpful in troubleshooting if users are experiencing problems with certain 

computers.  

 

Note: The center/computer check does not provide a microphone/audio check nor does it include the audio browser 

installation and check (see “Appendix B:  Software Installation Procedures” and “Appendix C:  Headset Procedures, 

System Check, and Audio Troubleshooting”).  
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When to Run a Center/Computer Check  
  

 When preparing for a test center’s first administration, run a center/computer check on each computer soon after 

you have installed and checked the audio browser (see Appendixes B and C). It is recommended to run the check at 

approximately the same time of day as when you plan to run the actual test administration so that bandwidth at the time of the 

administration can be estimated. A center/computer check should be run on each computer to verify that the results are similar for 

all computers to be used for the administration. If you use multiple test centers, a center/computer check must be run at each 

location.  

  On the day of each test administration, run a center/computer check again to confirm that the estimated number of 

concurrent users is similar for all computers and is not less than the number of examinees scheduled to test.  

  If new hardware/computers are installed or changes are made to the network/Internet connection, you must 

run another center/computer check.  

 

How to Run a Center/Computer Check  
1. Open Internet Explorer and go to the TOEIC testing website  http://toeicsw.ets.org .  

  
 2. Click the Center/Computer Check link on the right hand side of the screen. The computer check screen appears:  

    

3. Enter the required identifying information. Then click Run the Check. The checks will be performed automatically, 

as shown in the following screens:  

  
  Checking upload speed.  

   
Checking download speed.  

  

4. Review the Test Results screen. A sample is shown below.  

  If all areas of the check are green and all statuses are either “Passed” or “Supported,” the 

computer will be capable of delivering the tests.    

http://toeicsw.ets.org/
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Technical Details about the Center/Computer Check  

 
Appendix E:  Audio Quality Verification  
 
Audio Quality Verification Procedures  

To prepare for a test center’s first TOEIC administration, it is necessary to verify the audio quality on ALL testing 

workstations as follows:  

 

1. Contact TOEIC Technical Support (TOEICTech@ets.org ) to obtain TOEIC demo codes, which will 

be required to launch the test on each computer.  

2. Launch the TOEIC Speaking and Writing Demo test.  

3. Record audio responses to ALL of the Speaking items. It is recommended that you read aloud a newspaper 

or a magazine article to provide the audio samples. Note:  ETS verifies that all speaking items were 

completed, and a missing response will be interpreted as a failure.  

4. Logout of the test by pressing the key combination Shift +Ctrl+Alt+ F10.  

5. After delivering the demo tests on all testing workstations, e-mail the used demo codes to TOEIC 

Technical Support.   

6. TOEIC Technical Support will evaluate the audio quality and notify you of the results. If there is a 

problem with the audio quality, TOEIC Technical Support will work with you to resolve it.  

Important:   
  If you use multiple test centers, audio quality verification must be performed at each location.   

  It is important to perform the verification on each type of hardware used at your center(s).   

  Audio quality verification must be performed again if hardware changes, such as replacement of 

a sound card or headset, take place.  

  Keep track of which computer each demo code is used on. This will help target specific 

computers if problems occur.     

mailto:TOEICTech@ets.org
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Appendix G:  Handling and Reporting 
Technical Problems   
Common Technical Problems and Solutions  
 

Listed below are some common technical problems and their solutions.   

 
Windows Media Player Not Set as Default   
 
Issue: A media player other than Windows Media Player is installed and set as the default player. In this case, no audio 

playback is heard during the test.   

 

Resolution: Install Windows Media Player and make it the default player. See “Installing Microsoft Windows Media 

Player” in Appendix B:  Software Installation Procedures.  

 

Browser Check Recording Problem  
 

Issue: User cannot record their voice.    

 

Resolution: After plugging in the headset:   

 

1. Click the Start button in the bottom left corner of the screen.   

2. Point to All Programs, point to Accessories, and then click Windows Explorer.   

4. When the window opens, look under My Computer, and click on Local Disk (C :).   

5. Open the Program Files folder.   

6. Open the ITS subfolder.   

7. Open the Audio Browser subfolder.   

8. Open the Configure Audio Browser.exe file.   

9. When the window appears, make sure that Automatic is selected next to Configuration.  Note: You can 

also try selecting Default or Custom to see if they work better for your computer.   

10. Click Record, say something into the microphone, and click Stop.   

11. Click Playback. If the words you just recorded are played back, the problem is solved.  

 

Test Window Won’t Open/“Action Cancelled” Message   
 

Issue: Security programs can block access to the test window. In that case, the test window may not open at 

all or may display messages such as Action Cancelled, Access to this webpage has been blocked, or 

Access to this webpage has been denied, or the screen may go totally white and not display any message.    

 
Resolution: Here are some things to check:   

1. Is Norton Internet Security installed on this computer? If so, add the TOEIC testing website to the list of 

safe sites, close the browser, and try again.  

2. Is any other firewall program installed? If so, you may need to disable it before delivering the test.  

3. Is any security program installed (e.g., Norton Internet Security, MacAfee, F-Secure, etc.)? Drag the 

mouse pointer over the icons on the bottom right corner of the screen (to the left of the clock) and look  

for any security programs. If any are present, “Disable” or “Turn Off” the programs before delivering the test.  

4. Is this computer on a public network such as a library, school, or business? If so, it is possible that they 

have a firewall program at the network level. You will need to contact your IT department to add the TOEIC 

testing website to the list of allowed or safe sites.  
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Navigation -02 or Navigation-03 Errors   
 

Issue: A “Navigation-02” or “Navigation-03” error occurs whenever the connection to the Internet slows down, 

causing the session to time out or disconnect.    

 
Resolution:   

1. Clear the browser cache by going to Internet Options> General Tab>Temporary Internet files> Delete 

Files.   
2. Restart the computer, login again, and restart your test. No information will be lost, and the test should 

resume from where it was interrupted.   

3. If the same error message occurs again, you may need to contact your Internet Service Provider. You can 

also try to access the test at a different time or from a different computer that uses a different Internet 

connection.    

 

\Runtime Error   
 

Issue:  If Internet connectivity is interrupted while an examinee’s response is being uploaded to the ITS server, a 

Runtime Error will occur.  

Resolution: Reboot the computer and restart the test.    

 
Loss of Internet Connectivity  
 

Speaking test: If an Internet error message page appears on the computer screen, the Speaking test may be restarted 

after connectivity is restored.   

Writing test:  If an Internet error message page appears on the computer screen, the TCA must stop the Writing test 

and offer the examinee two options: a retest or a refund. Restarting a Writing test is not allowed in the event of an 

Internet error message page.  

For additional information, see also “Policy on Loss of Internet Connectivity During the Tests” on page H-1.  

When completing your Post-Administration Technical Feedback Report, include the following information:  If the 

Internet error message occurred during the Speaking test, state whether the examinee was able to complete testing. If it 

occurred during the Writing test, state whether the examinee chose to get a refund or a retest.  

 


